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  NorthStar Solutions has been producing high-quality, user-friendly software for 
many years.    Please visit Our Web Site for a list of other programs that you will likely find
useful.



Navigating Your Contact List
Find Last Name Feature
You can easily locate an entry by the last name just by typing in the last name in the Find 
Last Name text box at the top of the list box.    Note that you do not have to type the entire 
last name if it is found before you have completely typed it all out.    To quickly put the cursor
on that field, press ESC while anywhere on the main screen and the cursor will jump there 
for you.

The List Box
You can navigate your list of contacts using several methods.      "Manage Your Contacts" 
comes with a LIST BOX displayed on the right side of the main screen from which you can 
see several entries in the database.    To move to a particular item, simply click on its name.   
Another way to navigate the list box is to type the first letter as it is displayed on the left.    
For example, to go to the name Loydd, Greg, make sure the list box has the focus by clicking
anywhere in the list box, then press "L".    (Press "L" again to move to the next name 
beginning with "L" and so on.)    Generally, this Find Last Name Feature will be more useful 
than this because you are not limited to just the first letter of the name.

Pull-down Menu Keys
Another way to move through your contact list is to use the pull-down menu and/or hot keys 
associated with the menu items.    This is particularly useful if you prefer to use your 
keyboard or have collapsed the Window so that the list box is not displayed.    The menu 
items and their corresponding hot keys can be located from the FILE pull-down menu.    You'll
see from the menu that Ctrl-HOME   moves to the first entry  , DOWN ARROW   moves to the   
next entry, UP ARROW   moves to the previous entry  , and Ctrl-END   moves to the last entry  .

The Data Control Arrows
You can also navigate through your entries by using the arrow controls on the DATA 
CONTROL found at the bottom of the main screen.    The far left arrow   moves to the first   
entry, the inner left arrow   moves one entry backward  , the far right arrow   moves to the   
last entry, and the inner right arrow   moves one entry forward  .

Moving within an entry
To move forward one field, press TAB or ENTER.    To move back one field, press Shift-TAB 
(a.k.a. BackTab).    Of course, you can use the mouse to quickly move to different fields.

Show All with Same Last Name
This feature is found under the Input/Output    pull-down menu.    By selecting this option, all 
entries that have the same last name are found and displayed.

Show All with Same Business Name
This feature is found under the Input/Output    pull-down menu.    By selecting this option, all 
entries that have the same business name are found and displayed.
    



How to Pay for this Program

Please visit Our Web Site, which has the most up-to-date pricing information and 
offers several convenient ways for you to make your purchase.



Technical Support

Contact us using any of the methods listed below, and we will try to help.    (Please make sure you have 
read the Help provided with this program first.)

When contacting us, please be sure to explain as many relevant details as possible.    It is often helpful to 
also know what version of the program you are using and what operating system you are using it on.    
You may easily contact us via any of the methods noted below.    By far, e-mail contact is preferred 
because it is the most efficient method.    We check e-mail several times a day and can often respond 
very quickly (and in more detail, if needed).

E-MAIL
support@nstarsolutions.com

FAX
785 539-3743

MAIL
NorthStar Solutions
1228 Westloop Pl, #204
Manhattan, KS    66502-2840



Using Search/Filter/Sort Functions

"Manage Your Contacts" has several features to make retrieving an entry fast and easy.    The
SEARCH/FILTER/SORT feature allows you to narrow down the entries you wish to view.    For 
example, if you had several entries for different people that worked for the ACME Computer 
Company, you could build a search where "Business Name" is equal to "ACME Computer 
Company" to view only the people that work for that business.

Using that concept, "Manage Your Contacts" gives you a lot of flexibility and control over 
your contact list.    For example, suppose you wanted to mail a Christmas card to a select 
number of people in your list.    You could simply put a key word, such as "Christmas" in the 
NOTES section.    Now you will be able to filter for only those entries where "Notes" contains 
"Christmas".    (Note to use the word "contains" rather than "is equal to" so that the entry 
doesn't have to match exactly and may contain other items -- as the "NOTES" section will 
probably have many items in it.)

Using a slightly more sophisticated example, suppose you wanted to mail a newsletter to all 
your clients not living in the U.S.    Additionally, you know you can E-mail the newsletter for 
much less cost, but not all of them have E-mail.    By searching for all entries where the 
country field was not equal to "U.S." and where the E-mail field was "empty", you can easily 
identify which clients do not live in the U.S. and do not have E-mail.    (Note to actually use 
the word "empty" when searching for blank fields.)

Both the "Print Labels" function and the "Print Envelopes" function will allow you to print one
address at a time, or all the names currently displayed.    Now you can print an envelope or 
mailing label for all the entries you searched/filtered with that function.    I'm sure you'll be 
able to find many ways to ensure this program lives up to its name.



Using the Dialer
You can have your Hayes-compatible modem dial a number already keyed into your entry, or
you can manually enter a number from your keyboard.    If you are running under Windows 
9x, Manage Your Contacts will detect and use the Windows 9x Dialer automatically.    The 
dialer is automatically filled with the number you select in Manage Your Contacts.

If the dial feature is not dialing your modem, choose "SETUP!" and make sure it is configured
for the port your modem is using.    Also check to make sure your modem is working properly
and is correctly connected with your computer and phone line.    You should be able to check 
the connection and correct port settings with one of your other communications programs.    
NOTE: Your modem may be dialing, but you can not hear it doing so from its speaker. Pick up
your phone immediately after you select "DIAL" and see if you can hear the number being 
dialed.    Another option is to turn off your modem, wait a couple of seconds, then turn it 
back on.    This will reset your modem, and hopefully correct any problems you may be 
having.



Running the E-mail Robot for WINCIM or AOL.
If you're like me, you probably want a lot more control over the contact list that you use to 
correspond via e-mail on America Online or CompuServe.    For example, you may want to 
send an "e-mail newsletter" to a list of clients, but only certain ones.    Further, you may not 
want to have to retype or cut-and-paste several hundred times, nor do you want your clients
to necessarily know who all your other clients are, as happens when you use the cc" option.   
"Manage Your Contacts" helps you do this by automatically bringing the navigator to the 
foreground of your Windows session and plugging that relevant information (contact name 
and e-mail address) into the navigator of the online service so you don't have to retype that 
information.

In addition to not having to keep the internal "address book" up to date from within the 
navigator (all your information can be maintained within the "Manage Your Contacts" 
database), you can also use "Manage Your Contacts" to search or filter your entries for 
certain entries, then send the same e-mail message (e.g. an "e-mail newsletter")    to all 
those entries at once without having to do a lot of extra typing or "cutting and pasting".    
Here's how it works:

1) Start your navigator program and make sure it is NOT running minimized (not running as 
an icon).

2) Switch (ALT-TAB) to your favorite Windows word processor, Write, Notepad, etc. to 
compose your message, then copy it to the Windows clipboard (usually highlighting the text 
you want and pressing CTRL-C or highlighting the text and choosing "Edit", then "Copy" from
a pull-down menu will do this).

3) Switch (ALT-TAB) to "Manage Your Contacts" and filter your contact list to reflect all the 
contacts you want to receive your e-mail message.    (See "Search/Filter/Sort" from this Help 
file for more information about searching/filtering your contact list.)

4) Select "Send E-mail to all shown" from the Input/Output  pull-down menu, type in the title 
of your message, then sit back and watch "Manage Your Contacts" do the rest for you.

Note: If you wish to send an e-mail message to one person, it works similar to the above 
except that you do not have to worry about composing or copying text to the Windows 
clipboard.    Just start your navigator as described in step 1, then switch to "Manage Your 
Contacts" (ALT-TAB) and select "Send E-mail Message" from the Input/Output pull-down 
menu.    This will invoke your navigator, plug the e-mail address and leave you at the point 
where you can type in the subject and message as usual.



Printing Envelopes
You can quickly print one or many envelopes.    To access this function, choose the 
appropriate selection from the Input/Output pull-down menu.    There are few special 
considerations you need to be aware of when you print envelopes:

This function works on most laser and inkjet printers that use the HP (R) PCL (R) 4 
emulations.    I have successfully tested it on a Brother HL-630 printer, an HP DeskJet 540C, 
an HP LaserJet IIP, an HP LaserJet III, and an HP LaserJet IV.    Most printers emulate at least 
one of these and it is likely that your inkjet or laser printer does too.    If it does not, you will 
need to use mailing labels.

As a began researching adding this new feature, I soon found out that there are a variety of 
ways printers load envelopes (some load from the left side of the printer, some from the 
center, and some from the right -- no standards to make it easy).    It took some extra 
programming effort to accommodate all these different ways to load envelopes, but in an 
effort to make "Manage Your Contacts" as accommodating as possible, you can simply 
choose which method your printer uses by selecting "Envelope Settings..." from the 
Input/Output    pull-down menu (you can even adjust the margins for special envelopes, etc.).

Envelopes are printed directly to your printer.    Consequently, you may adjust the desired 
font for your envelopes using the external buttons on your printer.    One limitation is that 
you can not mix fonts, you must use one font for each line of the address.

Brother is a registered trademark of Brother Industries, Ltd.    Hewlett-Packard and PCL are registered 
trademarks and HP LaserJet IIP, HP LaserJet III, and HP LaserJet IV are trademarks of Hewlett-Packard 
Company.



Printing Labels and Reports
 
    "Manage Your Contacts" enables you to quickly print one or many mailing labels.    To 
access this function, choose Mailing Labels and Reports from the Input/Output  pull-down 
menu.    Just a few notes:

1) You can easily select and print several of the most popular Avery Laser labels.    Your local 
office supply store will almost definitely carry at least one of those label styles, referenced 
by their number.    To select a label type, just select the folder with its name.

2) For those of you that are using a dot matrix printer, you may be able to align your labels 
using the Avery Labels, or you can print simple, single-column dot matrix labels.    Its an 
option (one of the folders) in the label/report selection screen.

3) Because one of the most powerful, easy-to-use features of "Manage Your Contacts" has 
always been its ability to allow you to Search, Filter, and Sort you contact list the way you 
want, printing mailing labels also works in parallel with this feature:
    - Print a label or report for only the current entry
    - Print labels or report for all entries
    - Print labels or report for your entries the same way you 
        have chosen to Search, Filter, and Sort the list!

      Options are easily selected from the choices presented at the bottom of the screen.

4) You have the ability to begin printing laser labels from a position other than the top, left 
label -- so you can avoid wasting unused labels on a page.    Just select the starting position 
where you want your first label to begin printing (the default, of course, is the top, left label).

5) You will also notice there are reports available to print as well.    These should be pretty 
self-explanatory.    Note that you have the option to view the report in a Window before 
printing, which is the suggested thing you should do.    A Phone Book report is also available. 
Because many of us may like to have a simple printed list of our friends, etc. in a nicely 
condensed format (perhaps something you would have readily available in your desk or 
hanging on the refrigerator so that even if your computer is not on...).    This will print the 
name and phone 1 of the contact in a format that condenses all the information as much as 
reasonably possible.    I recommend that you first filter your list by people that have a phone 
number (e.g. phone 1 is not equal to empty) and perhaps sort it by last name as it would be 
in a phone book.    You may use other filters as well if, for example, you only wanted a certain
group of people on the printed list.



Using Search/Sort/Filter Functions
"Manage Your Contacts" is equipped to handle complex Searches/Filters/Sorts which you can 
define on an as-needed basis.    This feature and its ease-of-use is one of, if not the, best 
you'll find in any program of its kind.

Just select "Search/Filter/Sort" from the File pull-down menu, select the options from the pull-
down boxes to build your search criterion, choose "OK", and there you are!

The more entries and information you have, the more you can do with (and the more you'll 
appreciate) this powerful feature.    It really brings out the word "MANAGE" in "Manage Your 
Contacts".

See Example Using Search/Filter/Sort Functions to learn more about these powerful features 
and see some examples of how you can put them to good use.



Problems Importing Files
Importing files can have unpredictable results.    This is because it all greatly depends on a 
perfect, error-free file being imported from for it to work correctly.    If one field is missing or 
has invalid data, it could cause all the following fields to also have errors.

STEPS FOR REVIEWING AND CORRECTING ENTRIES WHEN THE IMPORT FUNCTION 
DOESN'T WORK RIGHT:

1) Prepare to View the Entries Just Imported
      The best way to review or edit the newly imported files is to browse all entries, sort by the
date, and move to the last entry -- this is done automatically for you at the end of the import
function.

2) Move back Through the New Entries until no Error is Found
    Move back (UP ARROW) one entry at a time until you come to an entry that does not have 
errors.

3) Move to the Next    Entry (The First Entry with an Error)
    Now move forward (DOWN ARROW) one entry and focus on that entry.    Chances are good 
that entry (or one near it) has errors in the file you are importing from.

As mentioned above, the file you are importing from must be exactly correct for the import 
function to work correctly.    Review Exporting/Importing Files
 from this Help file for more information about the correct format.    The most common errors 
include forgetting to account for fields that are blank (but must be accounted for), or not 
putting the fields in the correct order.

For exactly these reasons, the author of "Manage Your Contacts" prompts (and strongly 
recommends) that you make a backup of your data before you proceed to the import 
function.    If your list gets really messed up (especially a lot of entries), you can always 
restore from the backup.    Then you can identify where the problem exists in the file you are 
importing from (as discussed above) and try importing again.    Otherwise, you'll have to 
either manually correct the newly imported entries; or you'll have to delete the newly 
imported entries (Ctrl-Del), correct the file being imported from, and try importing again.



Overview
Becoming a Manage Your Contacts Expert
You will notice that this help file is not particularly large.    That is because we believe in 
making a program as intuitive as possible without much need for help.    On that note, this 
help system does not convey all the features, some are just too obvious to discuss in a help 
system.    Nevertheless, the help system is a good way to convey to you some useful 
information, or features that may be more sophisticated to use.    Do not feel like you need to
memorize a lot of commands and procedures to make this program useful: all the major 
features are made available via intuitive pull-down menu options.    Once you learn the 
different options available in the menus, you will essentially be a   Manage Your Contacts   
Expert  .  .  

Adding a New Entry
Probably the first thing you will want to do is add new entries.    This can easily be done by 
selecting "Insert a New Entry" from the File pull-down menu.    As you get more familar with 
the program, you will notice keyboard shortcuts can accomplish the same thing as accessing
the pull-down menus.    For example, another way to "Insert a New Entry" is to press Ctrl-
Insert on your keyboard.

Getting More Help
As noted, if you have played around with the program a little and read the help file, you 
should be well on your way to knowing the program; however, if you have any questions or 
comments about this program, feel free to contact us.    (See Technical Support for ways to 
get technical support)



Updating Changes
The most obvious way to update any changes you make to an entry is to select the Update 
Changes button that appears when a change to an entry has been made.    However, for 
added convenience, changes will automatically be made for you if you simply move to 
another entry using any of the methods discussed in Navigating Your Contact List.

If you make changes and do not want to keep them, you can easily select the Cancel 
Changes button that appears when a change to an entry has been made and this will restore
the    entry to the way it was before the changes were made.



(Registration Code)
Given to you after you register your copy (or copies) of Manage Your Contacts, this code will 
make your copy a fully-registered version.

This code is entered in the "Enter Registration Code" window which can be found under the 
Help pull-down menu on the main window (the window where you enter/view your entries).



Revision History
VERSION 4.1

» Added the ability to resize the screen a number of different ways to take advantage of higher screen 
resolutions and enable you to size the window more to your liking.

» Lengthened the maximum allowable size of the web site and e-mail address fields to 255 characters.

VERSION 4.0
» Added the ability to automatically compose an e-mail message to the contact name and e-mail address 
listed with the default e-mail client.    Use "Compose an E-mail Message..." from the "Input/Output" pull-
down menu.

» Added a new "Web Site" field so the web site associated with that person can easily be recorded and ...

» Added the ability to quickly visit the "Web Site" associated with the entry.    Use "Visit Web Site" from the
"Input/Output" pull-down menu.

VERSION 3.9
» Enhanced the Help System to support hyperlinks to the Internet.

» Polished the Help System in some areas to make it more succinct.

» Made many look and feel changes to bring the program more visually attractive.

» Added the ability to check for updates at the official Manage Your Contacts web site easily 
via the Help > About    window.

» Enhanced the installation routine.

VERSION 3.8
» Added a Search pull-down menu so you can quickly and easily access the search wizard, or
choose from some common, pre-configured search options (such as finding all entries with 
the same last name, the same business name, the same e-mail domain, etc.)

VERSION 3.77
» Added the ability to reshape the window so you can view only the data or both the data 
and the list box, and can elongate the window to view more of the list.    The way you left it is
also remembered for the next time you start the program.

VERSION 3.76
» Streamlined the look-and-feel of the program, added new hot keys for accessing some of 
the menu items, etc.

VERSION 3.75
» Reworked some of the Help System for more clarity and conciseness.

» Fixed an error that some systems experienced when viewing labels/reports in the Print 



Preview screen.

VERSION 3.7
» Enhanced the Search/Filter/Sort ability so you can add more criterion.

» Added the ability to quickly copy the First and Last Name fields into the Windows clipboard.

VERSION 3.6
» Added a new Phone Book report to the reports.    This report makes it easy to print out a list
of names and phone numbers so you can hang them on your refrigerator at home, put them 
on a bulletin board at your office, etc.

VERSION 3.52
» Manage Your Contacts now will detect and use the Windows 95 Dialer automatically.    This 
fixes a problem some Windows 95 users experienced when trying to auto-dial phone 
numbers since Windows 95 plug and play was not permitting it.    The dialer is automatically 
filled with the number you select.

VERSION 3.51
» Added the Find Last Name Feature so that you can quickly locate people by their last 
name.

» Added the Find All With Same Last Name Feature so you can quickly locate all the entries 
with the same last name.    (This feature is under the Input/Output  pull-down menu.)

» Added the Find All With Same Business Name Feature so you can quickly locate all the    
with the same business name.    (This feature is under the Input/Output  pull-down menu.)

» Added the ability to quickly paste information into a field.

VERSION 3.1
» Enhanced the way the windows are displayed on high-resolution monitors.

» Added better compatibility with International Date Settings

» Added the ability for one to just click once on the date and adjust the date via a calendar 
window.

VERSION 3.03
» A better installation routine is used for installing Manage Your Contacts.    

VERSION 3.01
» Minor fix to the installation routine.

VERSION 3.0
» Major enhancements to the way "Manage Your Contacts" prints mailing labels.    Namely 
the ability to select from several of the most popular Avery Laser labels, and an even easier 



interface for setting envelope settings.    (Support to print simple, single-column dot matrix 
labels still exists too).

» Because one of the most powerful, easy-to-use features of "Manage Your Contacts" has 
always been its ability to allow you to Search, Filter, and Sort you contact list the way you 
want, the mailing labels also works in parallel with this feature:
    - Print a label or report for only the current entry.
    - Print labels or report for all entries.
    - Print labels or report for your entries the same way you have chosen to Search, Filter, 
and Sort the list!

» Added the ability to begin printing laser labels from a position other than the top, left label 
-- avoiding waste of unused labels on a page.

» Added a redial feature to the dialer and made it so it will float on top.    Now you can keep it
running and redialing in the background while you work in either "Manage Your Contacts" or 
another program!

» Added two more phone # fields for a total of 5 phone # fields and moved the fields to a 
separate, convenient tab of their own.

» Major overhaul of the way reports are printed and added some new reports to select from.

» Some changes to the underlying database structure was necessary, see "UPGRADE.TXT" 
for instructions if you are upgrading from a previous version of "Manage Your Contacts".

» Fixed compatibility problems with some international (non-U.S.) date formats.

VERSION 2.31
» Minor upgrade has a new, professional Windows' help system.

» Added a scroll bar to the Notes section to make it easier to scroll a large amount of notes.

VERSION 2.3
» Automatically invoke and plug the e-mail address into either CompuServe Information 
Manager for Windows (WINCIM) or America Online for Windows navigator programs.    Allows 
multiple entries to be selected and then messages (e.g. "e-mail newsletters") to be sent with
just a few keystrokes.

» Added the ability to adjust the date and time stamped to the entry via an easy-to-use point
and click interface.    

» Added new options under the "Edit" pull-down menu to easily copy certain fields and/or 
groups of fields with minimal efforts.

» Although not a big problem (it never was even reported), I noticed that sometimes the 
reports didn't display right away and the display ratio had to be adjusted to get it to work 
properly.    This has been fixed.

» Enhanced the import/export options for column-formatted files so that carriage returns in 
the notes section will remain.    (By the nature of comma-delimited files, this is not possible, 
since each entry must be on one separate line.)



» Once again, no bugs have been reported despite a decent registration rate -- I really strive 
for this.

VERSION 2.2
» Added the ability to print envelopes on most HP compatible printers to include the HP 
LaserJet II series, HP LaserJet III, HP LaserJet IV, Brother HL 600 series, and HP DeskJet 500 
series.

» Added the ability to easily access Window's Calculator, Notepad, and Calendar programs 
via a pull-down "Utility" menu.    This should help many of you manage appointments and 
your "to do list".

» No bugs have been reported despite a healthy use/registration rate (I guess the new 
features were something a lot of people were looking for).    However, the name has been 
changed from "The Contact Manager" to "Manage Your Contacts" in order to avoid conflicts 
with a retail program of a like name.

VERSION 2.1
» Added the ability to delete all entries or a large group of entries that you have selected 
with the SEARCH/FILTER/SORT function.    

» Added the ability to point to any destination when backing up and restoring the database.

» Combined the various label setup functions into one common area.

» Added a tab-like interface for use with the NOTES field so that the notes area can be 
viewed in a larger area.

» Carriage Returns are now removed automatically when exporting, which is useful if you 
later wish to import the file.

» Added the ability to "dial" with the mouse if you don't want to use a number already keyed 
in or key one in via the keyboard.

VERSION 2.0
» Added a super Search/Filter/Sort wizard that allows you to build your own criterion to 
manage your contact list the way you want, the way you need, and easily.    It's extremely 
powerful 
and yet very easy to use -- just point and click.    This feature is clearly one of, if not the, best
feature you'll find in ANY application of its kind!!

» Streamlined the reporting functions to make them easier and with less overhead.

» You can now Import/Export comma-delimited files and files in an easy-to-read column 
format.

» Updated the underlying database structure so the Search/Filter/Sort functions could be 
made easier -- I'm sure all you care is that it works.    It works darn good.

VERSION 1.6
» Increased the number of fields you can sort on from the four main ones (Last Name, First 



Name, Business Name, and Date) to almost all of them (eleven total).    Sorry, in order to 
allow virtually unlimited amounts of data in the NOTES section, I had to define it as a 
data type that can not be sorted on, though it is still searchable.
    
» You can set your own option of when to print the country field while printing labels.
    
» Many of the fields have been increased to accommodate longer strings.    You should be 
able to enter data of any reasonable length.    (ie, the phone number has been increased 
from 20 to 35 characters, the e-mail address has been increased from 35 characters to 50 
characters)
    
» You can use the UP ARROW and DOWN ARROW to move one entry back or forward, 
respectively.    It used to be you had to hold the Ctrl key while using them.    Note
that using the Ctrl key has the same effect, but is no longer necessary.    I expect you'll 
quickly adapt to this easy enough <grin>.

» The reports have been aesthetically enhanced.



Benefits of Registering this Program

» You will be given a registration code to make your current copy a fully-registered copy.

» No more reminder screens.

» You will know in your heart that you have done the right thing (both legally and morally).

» You will be notified via Email of new releases along with a brief description of new features 
and any bug fixes.

» You will be eligible for a 50% discount on any major upgrades (minor upgrades are free) to the
latest, greatest version.    In other words you will be able to obtain a registered version with 
major new features for very little money.    (See the section called Revision History for an 
overview of the new features and fixes that have accompanied each new version.)

» Although technical support has not been much of a necessity, registered users are naturally 
given more priority and attention regarding technical support.



Using the Zip Code Locator
Manage Your Contacts comes with an optional zip code database of over 46,000 different 
U.S. zip codes associated with the appropriate city and state for each.    Using it is very easy,
just skip over typing in the city and state, type the 5- or 9-digit zip code, and the city and 
state is looked up and plugged in for you within just a fraction of a second!    If you would like
to have the zip code lookup feature, visit 
http://www.nstarsolutions.com/myc/zipcodes.htm for instructions on how you can 
download and install this feature with Manage Your Contacts for free.

The usual way you will probably use this feature is to save yourself some typing time by just 
entering in the known zip code so it will fill in the city and state for you.    However, you can 
also do a lookup of the zip code if you know the city and state and want to look up the zip 
code.    Just type in the city and state, double click on the City label and the zip code is 
looked up for you.    NOTE: there may be more than one zip code for a city.    If this is the 
case, you can double click again and the next zip code is presented, and so on.    Once the 
last zip code for that city and state is found you will be alerted.    Really, knowing the zip and 
not having to type in the city and state is the way this feature becomes more useful, but 
looking up zip codes is an option, nevertheless.

If the postal system added a new zip code for a city (one not already in the database), you 
will be alerted that the zip code was not found.    Just type in the city, state, and zip and you 
will be prompted to add it to the Zip Code Database so next time you use that zip code to 
find the city and state, it will be there!

Sometimes zip codes are changed to cities/towns that are just outside a main city.    While 
using the main city will often work within the postal system, you may wish to update the Zip 
Code Database to be more precise.    To do this, just double click on the Zip Code label and a 
window for adding new zip codes or updating existing ones in the Zip Code Database is 
presented.



Quickly pasting data to an entry
If you are using another Windows program to copy data over to an entry, you can quickly do 
so by copying the data into the clipboard, then double-clicking in the field where you want 
the data to go.



Exporting/Importing Files
 
    The file is exported into a carriage-return delimited file (and, thus, needs to be in the same
format if you are creating your own to import).    A file in a column format is easier to work 
with and much easier to view.    Rather than using quotes and commas to delimit their fields 
like a comma-delimited, text file does, each new field is placed on a separate line.    For 
example:

The field order is as follows:
NorthStar Solutions Business Name
Jeff First Name
Camino Last Name
(785) 539-3731 Phone 1
 <= Phone 2, though blank, is still accounted for. Phone 2
(900) 555-1234 Phone 3
(785) 539-3743 Phone 4
 <= Phone 5, though blank, is still accounted for. Phone 5
1228 Westloop Pl, PMB #204 Street 1
 <= Street 2, though blank, is still accounted for. Street 2
Manhattan City
KS State
66502 Zip
U.S. Country
starmail@compuserve.com E-mail
Author of this program.
Kansas State Wildcat fan.
*******              ********              *******    <= Notes section (may have multiple lines).    
Each new entry MUST be separated with 1 line whose first 7    characters are *'s.    (Additional
characters may be used to help you visually separate entries while preparing the source file 
to be imported.)

 If you experience any problems, please see Problems Importing Files



License Agreement
MANAGE YOUR CONTACTS - PRODUCT LICENSE INFORMATION

NOTICE TO USERS: CAREFULLY READ THE FOLLOWING LEGAL AGREEMENT.    USE OF THE 
SOFTWARE PROVIDED WITH THIS AGREEMENT (THE "SOFTWARE") CONSTITUTES YOUR 
ACCEPTANCE OF THESE TERMS.    IF YOU DO NOT AGREE TO THE TERMS OF THIS AGREEMENT,
DO NOT INSTALL AND/OR USE THIS SOFTWARE.    USER'S USE OF THIS SOFTWARE IS 
CONDITIONED UPON COMPLIANCE BY USER WITH THE TERMS OF THIS AGREEMENT.

1. LICENSE GRANT.    NorthStar Solutions grants you a license to use one copy of the version of this 
SOFTWARE on any one hardware product for as many licenses as you purchase.    "You" means the 
company, entity or individual whose funds are used to pay the license fee.    "Use" means storing, loading,
installing, executing or displaying the SOFTWARE.    You may not modify the SOFTWARE or disable any 
licensing or control features of the SOFTWARE except as an intended part of the SOFTWAREs 
programming features.    When you first obtain a copy of the SOFTWARE, you are granted an evaluation 
period of 30 days or 20 entries, whichever comes first, after which time you must pay for the SOFTWARE 
according to the terms and prices discussed in the SOFTWAREs documentation, or you must remove the 
SOFTWARE from your computer.    As a result of the opportunity you are given to first try the program 
before making a decision to purchase it, you understand and agree that no refunds will be made 
available.    This license is not transferable to any other company, entity, or individual.

2. OWNERSHIP.    The SOFTWARE is owned and copyrighted by NorthStar Solutions.    Your license 
confers no title or ownership in the SOFTWARE and should not be construed as a sale of any right in the 
SOFTWARE.
    
3. COPYRIGHT.    The SOFTWARE is protected by United States copyright law and international treaty 
provisions. You acknowledge that no title to the intellectual property in the SOFTWARE is transferred to 
you.    You further acknowledge that title and full ownership rights to the SOFTWARE will remain the 
exclusive property of NorthStar Solutions and you will not acquire any rights to the SOFTWARE except as
expressly set forth in this license. You agree that any copies of the SOFTWARE will contain the same 
proprietary notices which appear on and in the SOFTWARE.

4. REVERSE ENGINEERING. You agree that you will not attempt to reverse compile, modify, translate, or
disassemble the SOFTWARE in whole or in part.

5. NO OTHER WARRANTIES.    NORTHSTAR SOLUTIONS DOES NOT WARRANT THAT THE 
SOFTWARE IS ERROR FREE. NORTHSTAR SOLUTIONS DISCLAIMS ALL OTHER WARRANTIES 
WITH RESPECT TO THE SOFTWARE, EITHER EXPRESS OR IMPLIED, INCLUDING BUT NOT 
LIMITED TO IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR 
PURPOSE AND NONINFRINGEMENT OF THIRD PARTY RIGHTS.    SOME JURISDICTIONS DO NOT 
ALLOW THE EXCLUSION OF IMPLIED WARRANTIES OR LIMITATIONS ON HOW LONG AN IMPLIED 
WARRANTY MAY LAST, OR THE EXCLUSION OR LIMITATION OF INCIDENTAL OR 
CONSEQUENTIAL DAMAGES, SO THE ABOVE LIMITATIONS OR EXCLUSIONS MAY NOT APPLY TO 
YOU.    THIS WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS AND YOU MAY ALSO HAVE OTHER 
RIGHTS WHICH VARY FROM JURISDICTION TO JURISDICTION. 

6. SEVERABILITY.    In the event of invalidity of any provision of this license, the parties agree that such 
invalidity shall not affect the validity of the remaining portions of this license.
    
7. NO LIABILITY FOR CONSEQUENTIAL DAMAGES.    IN NO EVENT SHALL NORTHSTAR 
SOLUTIONS OR ITS SUPPLIERS BE LIABLE TO YOU FOR ANY CONSEQUENTIAL, SPECIAL, 
INCIDENTAL OR INDIRECT DAMAGES OF ANY KIND ARISING OUT OF THE DELIVERY, 
PERFORMANCE OR USE OF THE SOFTWARE, EVEN IF NORTHSTAR SOLUTIONS HAS BEEN 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. IN NO EVENT WILL NORTHSTAR 



SOLUTIONS' LIABILITY FOR ANY CLAIM, WHETHER IN CONTRACT, TORT OR ANY OTHER THEORY
OF LIABILITY, EXCEED THE LICENSE FEE PAID BY YOU, IF ANY.

8. GOVERNING LAW.    This license will be governed by the laws of the State of Kansas as they are 
applied to agreements between Kansas residents entered into and to be performed entirely within 
Kansas.    The United Nations Convention on Contracts for the International Sale of Goods is specifically 
disclaimed.

9. ENTIRE AGREEMENT.    This is the entire agreement between you and NorthStar Solutions which 
supersedes any prior agreement or understanding, whether written or oral, relating to the subject matter 
of this license.

 




